Mac® OS X 10.2.8, 10.3 to 10.3.9 / Microsoft® Windows® 2000/Windows XP

Adobe Illustrator® CS2

What’s New In Adobe Illustrator CS2

For many years, Adobe Illustrator software has been the standard for creating graphically rich content—first for print, then for motion graphics, then for the Web, and now for mobile devices. Creative professionals around the world depend on its innovative features and tight integration with other Adobe products. What more, you might ask, can a new version of Adobe Illustrator possibly deliver? The answer: quite a lot.

Here are just two examples of what’s brand new and remarkable in Adobe Illustrator CS2. Live Trace, a breakthrough new tracing tool, enables you to convert a scanned, hand-drawn sketch or photograph in seconds into a precise illustration composed of editable paths and anchor points. And Live Paint, an exciting new painting tool, allows you to apply color to strokes and fills easily and intuitively. With these powerful new features, Illustrator CS2 has narrowed the gap between the bitmap and the vector.

Adobe Illustrator CS2 is a powerful stand alone upgrade to Illustrator CS and illustration component of Adobe Creative Suite 2 software, a powerful, unified design environment that enables creative professionals to efficiently create and produce superb content in close collaboration with others. Illustrator CS2 gains from numerous Creative Suite-wide benefits, such as consistent color through shared color profiles and exchangeable swatches, improved Adobe Portable Document Format (PDF) creation and shared PDF settings, and enhanced file-version management.

Our prediction? No matter how well you already know Adobe Illustrator, you’re about to fall in love with it again. With Adobe Illustrator CS2, you will:

• Know no limits. With Illustrator CS2, your tools never stand in the way of your ideas. Live Trace and Live Paint equip you to focus on creating and producing great artwork. Additional features include: support for placing Adobe Photoshop CS2 layer comps and for applying Photoshop CS2 filters and effects; custom stroke placement; type enhancements; and support for colorizing grayscale images.

• Enjoy a smooth ride. Illustrator CS2 enables you to spend more time creating and less time mastering new features. The context-sensitive Control palette makes it a snap to find the tool you need for the task at hand. Still more additions—customizable workspaces—enable your work to flow smoothly from beginning to end, including a next-generation file browser called Adobe Bridge, and support for the latest Wacom tablets.

• Work well with others. Given today’s variety of media, no graphics application can afford to work all alone. Although artwork sometimes stays in Adobe Illustrator from start to finish, often it’s placed in other applications or saved in other formats. Illustrator CS2 smooths these transitions by providing support, for industry-standard PDF/X formats, and for mobile and Web formats such as Scalable Vector Graphics (SVG) and Macromedia® Flash™ (SWF).

From the Adobe Illustrator CS2 welcome page, you can browse a wide variety of Cool Extras, including over 270 new, professionally designed templates, more than 100 royalty-free OpenType® fonts, and over 100 libraries, including Brushes, Gradients, Graphic Styles, Patterns, Swatches, and Symbols. You can also access numerous training and support materials.
Know No Limits
Adobe Illustrator CS2 provides two ground-breaking tools to expand your creative possibilities and improve your productivity. Live Trace converts bitmaps into fully editable, scalable vectors in seconds. Live Paint enables artwork to be colored quickly and intuitively. Together, Live Trace and Live Paint break down the boundary between drawing and painting, removing the obstacles between your first ideas and final results.

In addition to Live Trace and Live Paint, Illustrator CS2 provides several new tools that allow you to work even more freely. Support for Photoshop CS2 layer comps enables you to import variations on Photoshop artwork into Illustrator CS2. You can also apply Photoshop filters and effects using the Photoshop Filters Gallery and Effects Gallery built into Illustrator CS2. You can tailor the placement of strokes—along the outside, center, or inside of a path—to suit your style and your projects. You can use the new type enhancements to underline URLs in Web comps. And you can colorize grayscale images and create drop shadows using spot colors, then preview and print them accurately.

Convert Bitmaps to Vectors with Live Trace
Adobe Illustrator CS2 includes a sensational new feature, Live Trace, which narrows the inconvenient gap between vector and raster (and between paper and screen). How many times have you roughed out an idea on the back of a paper placemat, only to recreate your work from scratch when you get back to your computer? How often have you wished you could scan a photograph and convert it directly to vector as the starting point for an illustration? With Live Trace, you can do both—and more.

Live Trace is stunningly easy and fast—a single click turns pixels to vectors in a matter of seconds. Built-in preset tracing presets help you get good tracing results from the start. So scan that hand-drawn placemat sketch and use Live Trace to transform it into scalable vector artwork. Open that JPEG photograph and convert it into editable paths and anchor points. Illustrator CS2 provides everything you need for bitmap-to-vector conversion—you don’t have to choose between starting with a blank page or using another tool.
What makes Live Trace “live” is a preview feature that preserves the original bitmap while you experiment with tracing presets ranging from color swatches to pixel value thresholds. If you don’t like a particular setting, choosing Undo restores the original bitmap completely intact. What’s more, Live Trace is not only live, it’s also smart—its creation of paths and anchor points rivals that of the most skilled Illustrator artist.

When tracing in color, you have two choices: allow Live Trace to determine the colors in the traced artwork based on colors in the original, or specify a swatch library from which Live Trace will automatically draw to match traced colors to original colors. Tracing with a swatch palette makes it easy to work within specific color requirements—say, for corporate signage or limited-color print work. For example, scanning a packaging comp using a client’s six-color palette saves your having to apply individual colors one at a time. After tracing, you can swap individual colors or entire palettes.

Live Trace includes 13 sets of tracing presets optimized for different types of raster art, such as color and grayscale images, hand-drawn sketches, detailed illustrations, comic art, inked drawings, technical drawings, black-and-white logos, and type. To apply a similar look and feel to dissimilar bitmap artwork, you can save your own sets of tracing presets, and to speed up tracing many images at once, you can use new built-in automation scripts from Adobe Bridge (described below).

Take Live Trace for a spin, first by itself, and then in combination with the next spectacular new Adobe Illustrator CS2 feature—Live Paint.

**Apply Color with Live Paint**

If you often apply color to vector artwork, you’ll love the Illustrator CS2 Live Paint feature. Live Paint equips you to paint artwork quickly and intuitively, without having to painstakingly create and layer objects just to carry color. Open the artwork, click to convert it to Live Paint objects, and use the Live Paint Bucket to apply color anywhere you want it. You can use Live Paint either to further refine artwork you’ve just traced with Live Trace, or to apply color to any existing Illustrator artwork.

Live Paint uses two new Illustrator object type that include regions and edges. Regions and edges are like Illustrator fills and strokes, except that they exist in single-layer world: where two edges intersect, another edge is created; where two regions overlap, a third region is created. As a result, what looks like a paintable edge or region is a paintable edge or region—what you see on screen is what you get when you apply color. Like Live Trace artwork, Live Paint objects remain “live” as long as you want them to.

With Live Paint, you can paint artwork quickly and intuitively based on how it appears on screen rather than how it was constructed and layered.
For example, imagine two overlapping objects, a circle and a square. As standard Illustrator objects, they would each consist of one stroked path and one fill, with one object in front and the other behind. As Live Paint objects, instead they consist of four edges and three regions—all on the same layer. What’s more, Live Paint objects retain a dynamic relationship to each other: repositioning the objects causes the overlapping region to change shape accordingly—while retaining its color. Moving the Live Paint Selection Tool around the artwork outlines each paintable edge or region. You can select any combination of edges and regions and then apply color—as well as copy, paste, cut, and delete—in all the usual ways.

These behaviors make Live Paint ideal for meeting a common illustration challenge: quickly creating colored shapes. Instead of painstakingly reconstructing strokes and fills to produce specific colored shapes, just select and paint the edges and regions you want, then cut, copy, or paste them into any Illustrator CS2 artwork. You’re free to experiment all you like—no tedious aligning corners and edges at super-high zooms, and no reworking of paths if you change your mind.

You can use the Gap Detection feature to identify where non-intersecting edges leave gaps through which color can leak into adjacent regions. You can turn on Gap Detection to view gaps as you work and instruct Illustrator CS2 to automatically either stop paint at gaps or close gaps by extending the artwork’s strokes. You can also specify the size of the gap that Illustrator CS2 will detect and repair.
Tighter Integration with Adobe Photoshop CS2

Adobe Illustrator has always provided exceptional support for opening, importing, and exporting Photoshop files. Now, Illustrator CS2 extends this support even further. As part of Adobe’s ongoing effort to tightly integrate all Creative Suite applications, Illustrator CS2 software enables you to open a Photoshop file containing layer comps, then preview and select which comps to import. (The Photoshop layer comp feature allows you to create, view, name, annotate, and manage multiple versions of a layout in a single file.) Just as easily as you’ve always controlled the visibility of regular Photoshop layers, now you can set the visibility of layer comps—whether the Photoshop file is opened, linked, or embedded. Designers can either choose to import either a single layer comp or all layers from a Photoshop CS2 file, then continue to refine the layers in Illustrator CS2.

Also new in Illustrator CS2 is direct access, within the Filters menu and the Effects menu, to the Photoshop CS2 Filters and Effects and the Photoshop CS2 Gallery. Here you can preview, refine, and apply Photoshop CS2 filters and effects such as Fresco, Gaussian Blur, or Mezzotint to any Illustrator artwork, text or placed image. Photoshop filters and effects behave in Illustrator CS2 the same as Illustrator effects: effects are live, which means they are non-destructive. You can continue to modify the effect’s options or remove the effect at any time without altering the underlying artwork, text, or image. By contrast, filters change the underlying Illustrator CS2 artwork.

Custom Stroke Placement

Adobe Illustrator CS2 enables you to specify whether strokes are placed along the inside, center, or outside of a path. Whether you’re drawing by hand and want the stroke to follow the gestures of your pen, or setting chokes and spreads for manual trapping, or placing pixels for precise Web graphics, you can choose a stroke placement that fits your need. You can also determine whether the coordinates and alignment of stroked objects are based on their paths or on the edges of their strokes.
Type Enhancements
Illustrator CS introduced more than 175 new type enhancements. Now Illustrator CS2 includes two more—underline and strikethrough styles—to round out an already robust set of typographic features. The overall performance and stability of Illustrator’s type features have also been improved. And because Illustrator CS2 shares the same composition technology as Adobe Photoshop CS2, Adobe After Effects® and Adobe Premiere®, text created in any of these applications retains its editability, formatting, and other attributes in the others. Finally, Illustrator CS2 can export Photoshop files in which the text in grouped text boxes remains editable.

Improved Color Management
Using Adobe Bridge (a component of Creative Suite 2 software, described below), you can synchronize color settings for Illustrator CS2, Photoshop CS2, InDesign CS2, and GoLive CS2 so that color profiles are consistent in all four. For example, you can create artwork in Photoshop CS2, add type in Illustrator CS2, and then place the completed work in an InDesign CS2 layout or a GoLive CS2 Web page—and the colors will appear the same in each. New color management features in Adobe Illustrator CS2 improve your control over rich blacks and CMYK values and enable you to exchange color swatches with Photoshop CS2 and InDesign CS2.

Apply Spot Colors to Grayscale Images and Drop Shadows
Illustrator CS2 provides extended support for using spot color to enhance grayscale images and drop shadows—simply drag a spot color swatch onto the grayscale image or drop shadow, or click a spot color swatch on the swatches palette. These spot colors will preview and print accurately as separate plates.

What’s more, spot colors applied in these ways are correctly preserved when saving the artwork as AI, EPS, or PDF files, or when exporting it in legacy AI or legacy EPS formats. Such spot colors will also print accurately if the artwork is placed in InDesign CS2 or QuarkXPress 6 layouts or documents printed with Acrobat 7.0 Professional software.

Enjoy a Smooth Ride
Adobe Illustrator CS2 provides several new and enhanced features that enable you to quickly locate and master new tools and tailor your work environment to different tasks and projects. You can access tools directly from a new context-sensitive Control palette, open, save, and share custom workspaces with palettes arranged exactly the way you want, draw quickly and fluidly using the latest Wacom tablets, and easily find and manage creative assets with the new Adobe Bridge file browser. The intelligent, streamlined Adobe interface supports rather than interferes with the momentum of your work.

Control Palette
To make tools easier to locate and select, Illustrator CS2 includes a context-sensitive Control palette, similar to the InDesign Control palette. Instead of opening multiple palettes, you can access commonly used tools—what you’ll need for nearly 80 percent of your work—from one compact location. For example, you can specify font, style, and size without opening the Character palette, or stroke and stroke weight without
opening the Stroke palette. When you do need access to a full palette, just click on any element underlined in blue to display additional relevant options. Not only does the control palette free up screen real estate for your artwork, it streamlines finding the tool you need when you need it—without searching through multiple menus and palettes. Don’t just take our word for it—close all palettes except the Tool and Control palettes and see how easy it is to work.

Custom Workspaces

Different illustration projects require different tools. For example, a web designer preparing 3D objects for Flash (SWF) animation might require only the Color, Layers, and Appearance palettes, while a print designer creating a calligraphic menu cover might need only the Character, Paragraph, OpenType, and Swatches palettes. Adobe Illustrator CS2 software enables you to select and arrange palettes to support a particular workflow or client project, save that arrangement as a named workspace, then activate it quickly and easily from the Window menu at any time or share it with another user or computer. Minimal, one of two preset workspaces, provides maximum work area by displaying only the Tool and Control palettes. Especially well suited for pen-and-tablet users, this workspace will also appeal to anyone seeking lots of room for creative maneuvering, since they can reach nearly 80 percent of the tools they’ll need from the Control palette alone.

Support for Wacom Tablets

Before the mouse, there were pencils, pens, brushes, and markers. For artists who still prefer those tools—either once in a while or all the time—Adobe Illustrator CS2 has been optimized for the latest Wacom tablets accessories, including the Intuos3 tablet and Grip Pen, Airbrush, and 6D Art-Pen. Enjoy the ease and natural feel of pressure-sensitive hand drawing, along with brand-new Intuos3 features such as tilt sensitivity for detecting the degree and direction of the pen angle. Illustrator CS2 Calligraphic brushes include for the new 6D Art-Pen that allows for barrel rotation.
Adobe Bridge

Get fast, efficient access to all your creative assets using the new Adobe Bridge, a versatile file-browsing application that is part of Creative Suite 2 and tightly integrated with all Creative Suite 2 components—Illustrator CS2, InDesign CS2, Photoshop CS2, and GoLive CS2 software. Now you can locate, browse, and organize files more easily, and drag and drop files directly into your Illustrator artwork. Adobe Bridge keeps native AI, INDD, PSD, and Adobe PDF files, as well as other Adobe and non-Adobe application files, at your fingertips. Numerous views of assets, including Thumbnails, Filmstrip, Details, and Versions and Alternates, make it easy to find and identify particular assets. A Preview pane enables you to search even more thoroughly by scrolling Adobe PDF and InDesign templates page by page.

Thanks to built-in XMP metadata support, you can view detailed information about assets, such as the creation date or copyright information. You can search for one or more assets with common metadata attributes—such as all files that use a certain Pantone® color or set of fonts. And you can embed additional metadata into an asset without opening the file. Adobe Bridge also automates a variety of labor-intensive tasks with built-in scripts that work across all Creative Suite 2 applications. For example, you can batch-process artwork using Live Trace presets. Adobe Bridge also provides centralized workflow automation, consistent color settings, and Adobe PDF file presets.

The Adobe Stock Photos* service, accessible from within Adobe Bridge, provides designers with one-stop shopping for high-quality, royalty-free stock images and illustrations—from within the familiar Adobe interface. It offers an efficient and convenient way for creative professionals to browse, compare, and purchase image content provided by some of the leading stock photo agencies. With your Illustrator artwork open, you can jump to Adobe Bridge, browse collections from multiple stock houses, and download low-resolution comps to the Adobe Bridge without missing a beat. When your client approves the image, you can download and license full-resolution image in a single transaction to the Bridge or via the Illustrator Links palette, even if you’re buying images from more than one source. Once you’ve downloaded comps and/or high-resolution images, you can preview, organize, and search them using Adobe Bridge just like any other assets. (For more information, refer to “What’s New in the Adobe Creative Suite 2.”)

*Adobe Stock Photos may not be available in all countries, languages, or currencies, and is subject to change and to the accompanying terms of service.
Work Well With Others

Whether you’re creating packaging for print, animations for the Web, or graphics for mobile phones, Adobe Illustrator CS2 tools make it easier than ever to collaborate creatively from first idea to final review. Plus you can work more efficiently—thanks to enhanced features for producing Adobe PDF files, new print capabilities, and improved support for a wide variety of file formats, including Macromedia Flash (SWF) and Scalable Vector Graphics (SVG) for Web and mobile content creation.

Expanded Support for Mobile Content

Scalable vector graphics (SVG) is an evolving set of open-standard file formats that use XML syntax to describe images as resolution-independent shapes, paths, text, and filter effects. SVG file formats are developed and supported by the World Wide Web Consortium (W3C) as a means for creating compact, scalable, high-quality graphics on the Web, in print, and on mobile devices such as cell phones and PDAs. Already well equipped for SVG authoring, Adobe Illustrator CS2 now supports the latest SVG 1.1 format for the Web, as well as SVG Tiny (SVG-t) and SVG Basic, two emerging mobile SVG formats that allow you to author artwork once for optimized display on any wireless handset. You can also refine SVG content for mobile devices using Adobe GoLive CS2. (For more information, refer to “What’s New in Adobe GoLive CS2.”)

Additional features enable optimized font quality, minimized file size, and previewing an SVG document and SVG code in a Web browser equipped with the Adobe SVG Viewer plug-in (included with Adobe Illustrator CS2). With Illustrator CS2, designers can keep pace with innovative applications such as animated picture messaging, mobile e-commerce, and mobile entertainment.

Support for Macromedia Flash (SWF)

Adobe Illustrator CS introduced powerful new tools for creating three-dimensional (3D) objects by blending two-dimensional (2D) artwork. Now, Illustrator CS2 enables artists to export text, artwork, or a blend-based 3D object as an animated Macromedia Flash (SWF) file. New export features provide control over how Illustrator layers map to animation frames. Additional new options include the choice of maintaining the appearance of text by exporting it as curves, preventing Flash (SWF) files from being imported by other applications, and compressing a SWF file.

Artists can export text, artwork, and blend-based 3D objects as animated Flash (SWF) files, controlling how Illustrator CS2 layers map to animation frames.
Adobe PDF Enhancements

All components of Creative Suite 2, including Illustrator CS2, provide new global presets for creating reliable, consistent Adobe PDF files. The six presets cover common Adobe PDF workflows: Smallest File size, for files distributed on the Web; High Quality Print, for design comps; Press, for high-quality print production; PDF/X-1a and PDF/X-3, for prepress workflows employing these industry-standard formats; and Illustrator [default] for placing Illustrator files in other applications. All Adobe PDF presets are available to Creative Suite 2 applications from a single location, which makes the presets easy to manage. What's more, they can be customized for specific workflows, loaded into any Creative Suite 2 application, and shared with clients and prepress partners. In addition, the presets are consistent with the job options in Acrobat Distiller.

So no matter where designers create PDF files—directly from within Illustrator CS2, InDesign CS2, Photoshop CS2, or GoLive CS2 software, or by printing to Adobe PDF from non-Adobe applications—they work with the same options and achieve more consistent results.

Support for Printing Overlapping Tiles

Whether for packaging or posters, printing oversize illustrations is a must for many Illustrator artists. This common task entails printing tiled pages to a desktop printer and assembling the tiles into a full-size comp. While previous versions of Illustrator allowed pages to be tiled, Adobe Illustrator CS2 enables artists to specify how much tiles will overlap with each other. Printing with an overlap makes it much simpler to combine tiled standard-size sheets into an oversize whole.

Moreover, Illustrator CS2 can save tiled pages to a multi-page PDF file instead of producing a single PDF file. This makes it convenient for designers to send a single PDF file rather than many files to clients for producing their own full-size comps. Conversely, some designers lay out multi-page documents by setting up a single oversize page as though it were composed of individual pages or panels, then placing elements so as to determine the “page” on which they appear. In this instance, printing a tiled PDF document splits the single oversize page into separate pages in the PDF file, making the document easier to review and print.
Availability and Pricing

In the United States and Canada, Adobe Illustrator CS2 for Macintosh and Windows is expected to ship in the first half of 2005.

The estimated street price for Adobe Illustrator is $499 (U.S.) for all platforms. Registered users of any version of Adobe Illustrator can upgrade to Illustrator CS2 for only $169 (U.S.). Users of CorelDraw and Macromedia FreeHand can also purchase Adobe Illustrator CS for only $349 (U.S.).


About Adobe Systems Incorporated

Founded in 1982, Adobe Systems Incorporated (www.adobe.com) builds award-winning software solution for network publishing, including Web, print, video, wireless, and broadband applications. Its graphic design, imaging, dynamic media, and authoring tools enable customers to create, manage, and deliver visually rich reliable content. Headquartered in San Jose, California, Adobe is the second largest PC software company in the U.S. with annual revenues exceeding $1.6 billion.